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Line Art Image
Line art images contain areas of solid black and white pixels.



Halftone Image
Halftone images contain black and white pixels arranged in a pattern to simulate grayscales.



Copy
The section of the image you have selected has been copied to a temporary file and will remain stored 
there until another copy operation is performed.



Copy to Clipboard
The section of the image you have selected has been copied to the Windows Clipboard. The copied area 
can now be pasted to any application supporting the Windows Clipboard function.



Drag and Drop
With this function you can move one or more files or items to another window or frame quickly by 
selecting them and then dragging them to their new destination. 

When dragging an item, the mouse cursor will change to the  or 

 symbol to indicate that the item can be dropped onto the current location. If the mouse cursor turns to
the 

 symbol, the item cannot be dropped onto the current location.



Selection with the mouse
The File Selector Window displays files in a small size so that you can easily select the files you want to 
include in a presentation. Files can be selected the same way the Windows File Manager works.



OK
Press the "OK" button to accept the current settings.



OK
Press the "OK" button to finish working with the current dialog.



Done
Press the "Done" button to finish working with the current dialog.



Cancel
Press the "Cancel" button to undo the settings made or to leave the dialog.



Help
This option shows the program's Help file index.



Info
This button shows the program information window containing copyright information and the version 
number for the actual program.



Power
Press the "Power" button to close the program window.



Exit
Press the "Exit" button to close the program window.



Password
When the check box beside Password is selected, the screen saver can only be de-activated when the 
correct password is entered in the text box. 



Password
The Password button is used to access the Windows password dialog box. 
Enter your personalized password and click on OK. To de-activate the screen saver you must enter this 
password when prompted by the dialog box to do so.





Add
The Add button is used to include a new item to the play list. 



Add
The Add button is used to include a new transition to the play list. 



Delete
Delete is used to remove the selected items from the play list.



Delete
Delete is used to remove the selected transition from the play list.



Edit
Edit is used to change the settings of the selected item.



Rename
Rename is used to rename the selected item of the play list.



Back Button
This button allows you to set the red positioning bar back one step.



Pause Button
Pressing this button halts the selected media. Press the Pause button again to continue.



Stop Button
Pressing this button stops the selected media.



Stop Button
Pressing this button stops the preview.



Play Button
Pressing this button plays the selected media from the current position indicated by the red bar of the 
Control Area.



Play Button
Pressing this button plays all transitions from the current position indicated by the highlighted entry of the 
play list.



Forwards Button
This button allows you to preset the red positioning bar.



File Information Area
This area shows the name and path of the selected media file.



File Information
Displays information about the selected media file.



Play List Area
This area shows all entries of the current play list.



Play List Area
This area shows all entries of the current play list. The individual transitions are used as intermediate 
steps to create the final video.



Display Order
The Display Order list box is used to select the order in which the items of the play list are displayed when
the program is active. The following options are available:
Forward: Displays items in numerical order - i.e. starting with number 1.
Reverse: Displays items in reverse order - i.e. starting with the last item.



Play Order
The Play Order list box is used to select the order in which the items of the play list are played when the 
program is active. The following options are available:
Forward: Plays items in numerical order - i.e. starting with number 1.
Reverse: Plays items in reverse order - i.e. starting with the last item.



New
Clicking on the New button creates a new play list.



Play List
This window shows all entries in the current play list.



Open
Open is used to load an existing play list from the hard disk drive.



Save
The Save button is used to save the current play list to the hard disk drive.



Save as
The "Save as" button is used to save the current play list to the hard disk drive.



Top
The Top button moves an item in the play list window to the top of the list.



Up
The Up button moves an item in the play list window one step upwards.



Down
The Down button moves an item in the play list window one step downwards.



Bottom
The Bottom button moves an item in the play list window to the bottom of the list.



Loop
The "Loop" control is used to play a selection continuously until it is manually stopped.



Sound
The "Sound" control is used to turn the sound on or off.



Screen Mode
The "Screen Mode" control is used play a selection in full screen mode or in the program window.



Step Back
This button allows the track number to be set back one step.



Step Forward
This button allows the track number to be set forward one step.



Track
This display shows the current track.



Time
This display shows the actual time of the current track.



Name
This display shows the name and path of the current media file.



Preview Area
This area shows a preview of the selected video.



Preview Area
This area shows a preview of the current transition.



Start
The "Start" button is used to create a video based on the current settings.

1. Click on the "Start" button on the Control panel.
2. A dialog will appear showing the progress in the creation of the video.





Info
The Info button is used to display information on the selected video.



Start Offset
This option allows the starting point within the selected video to be set.



End Offset
This option allows the end within the selected video to be set .



Duration
This option allows the duration within the selected video starting with the Start Offset to be set.



Video Control Area
This area shows offsets, duration and the current position within the selected video. Set the red bar to the 
position you want to see.



Video Control 
This control allows you to change offsets and the duration within the selected video. Use the mouse to 
move or resize the Video Control.



Back Button
This button allows you to set the red positioning bar back one step. The red bar can be set in 25 steps.



Pause Button
Pressing this button halts the selected video or animation. Press the Pause button again to continue.



Stop Button
Pressing this button stops the selected video.



Play Button
Pressing this button plays the selected video from the current position indicated by the red bar of the 
Video Control Area.



Forward Button
This button allows you to preset the red positioning bar. The red bar can be set in 25 steps.



Set Start
Pressing this button sets the starting point while playing the selected video.



Set End
Pressing this button sets the end point while playing the selected video.



Test
Pressing this button allows you to watch the edited sequence of the selected video.



Replace
This option allows the selected video to be replaced with a new one.



Preview Area
This area shows a preview or the the edited sequence of the selected video. It is also used to set the size 
and position of the selected video.



Preview Area
This area shows a preview of the selected video.



Display Size
The Display Size is used to change the size of the selected video. Use the Custom option and the 
Preview Area to set the video to any arbitrary size.



Preview
This area shows a preview of the currently selected video frame.



Open
The Open command is used to load a new video file.



Type
Allows you to choose the image type, either full color or 256 colors, in which the actual frame will be 
saved.



Frame Number
This text edit box shows the number of the currently selected video frame. Type a number to get the 
desired frame or use the frame selector below to browse through the video.



Frame Selector
The frame selector is used to select a frame while stepping through the video. The selected frame is 
shown in the Preview area.



Image Type
Allows you to choose the image type in which the wallpaper will be saved.
The following types are supported:
16 Colors, 256 Colors and True Color



Image Type
Allows you to choose the image type in which the image will be saved.
The following types are supported:
256 Colors and True Color



Image Size
Determines the image size in which the wallpaper will be saved. Use Aspect Ratio to keep the original 
proportions of the video frame.



Export
The Export button is used to add a video frame to the Files Available list in the main window. Selected 
files will be saved into the Windows directory in the BMP file format in the size and image type selected. 
The converted images can now be selected from the Files Available list box for inclusion in the Wallpaper 
list.



Import
When the Import button is activated, a dialog box will appear on the screen where video frames can be 
converted for use as wallpaper.



Image Type
Allows you to choose the image type in which the video will be saved.
The following types are supported:
256 Colors and True Color



File Type
Allows you to choose the file type in which the video will be saved.
The following types are supported:
Video for Windows (AVI)



Image Size
Allows you to choose the image size in which the video will be saved.



Frames
Allows you to choose the number of frames in which the video will be saved. The more frames are being 
chosen, the smoother will be the resulting morph effect.



Frames
Sets the number of frames per second for the final video. The higher the number of frames per second, 
the smoother the video will appear when it is played back.



Preview
This area shows a preview of the currently selected video morph.



Display Image
This option lets you watch the transformation of the image while previewing the morphing process. If this 
option is swwitched on, you will get a clear preview of the morphing process. However, this option is very 
time consuming.



Display Mesh
This option lets you watch the transformation of the area settings while previewing the morphing process. 



Size
The size of the video is displayed here. Select a standard size or the "Custom" setting.



Aspect Ratio
The "Aspect Ratio" check box is activated when "Custom" is selected. The aspect ratio can be maintained
or by deactivating the check box, any size can be entered in the text box.



Frames per Second
The number of frames per second for the preview video is displayed here. The default value is 15 frames 
per second. A faster video preview can be made when the number of frames per second is set to a low 
number (e.g. 5). 



Frames per Second
Sets the number of frames per second for the final video. The maximum number of frames per second is 
30.



Create temporary file
When selected, the video preview will be written into a temorary file.



Selected Area
This list box is used to select the area for the video file - either the complete project or the selected area 
only. To check the effect of a short sequence in a video, the setting "Selected Area" should be used.



Project Name
Displays the name of the project file. When a new project is opened, the Construction window (Untitled) 
will automatically appear.



Time Line
When creating a new video file, the time line is used to accurately place media files in the various tracks 
on the Construction window .The scale displayed on the time line is the current setting displayed in the 
"time scale" list box. If the current scale is set to "1 frame", then a single frame will be displayed between 
two points on the time line; if the current scale is set to "15 frames", then 15 frames will be displayed 
together as a single frame on the time line. The time line is a very useful when editing a video file. 



Preview Area
A selection can be made for the video preview in the preview area. 



Video Tracks
The video tracks are used for video, animation, and image files.



Transitions Track
The transition track is used for transition effects between video track 1 and video track 2.



Text Track
The text track is used to display the text which was created in the text window.
Hier legen Sie den Text ab, den Sie im Textfenster erzeugt haben.



Audio Tracks
The audio tracks are used for audio files.



Frequency Curve
The frequency curve of a sound file is displayed in the blue area on the top half of the sound track.



Volume Control
The volume of a sound file can be modified in this area of the sound track. To change the volume, click on
the thin line running through the middle of this area. A square will appear which can be dragged up or 
down to adjust the volume accordingly.



Time Scale 
This list box is used to select the time scale for the time line. Settings ranging from 1 frame to a maximum
of 1 minute can be made. The default setting is 2 seconds. The selected scale is displayed on the time 
line on the top of the Construction window.



Scroll Bars
Click on the scroll bars or on the scroll arrows to move the display in the Construction window to the left 
or to the right.



Compression
Select the desired compression method from the list box.



Quality
The quality value supported by the compression method is displayed here.



Key Frames
The number of key frames supported by the selected compression method is displayed here.For 
example, if 15 is displayed in the text box, the complete frame will be compressed and saved every 
fifteenth frame. Only the changes in the following 14 frames in relation to the key frame will then be 
compressed and saved in the video file.



Color Depth
The color depth supported (8, 16 or 24 bit) is dependent on the selected compression method.



Half Frames
This function is supported only by hardware which can split the lines in a video image in even and odd 
lines (half frames). The result is a doubling of the number of frames in the video creating a very smooth 
effect.



First Line
Selection box for half frames. If the setting "Even Lines" is selected, then the first half frame will contain 
even lines and the second half frame the odd lines.



Background
This option allows you to choose the background color of the text.



Foreground
This option allows you to choose the color of the text.



Face Color
This option allows you to choose the color of the front side of the text.



Side Color
This option allows you to choose the color of the sides of the text.



Text
This field allows you to edit the text. The text can be as long as 512 characters and allows carriage 
returns. Carriage returns can be entered by typing in Ctrl+¶ or Ctrl+m.



Text
Text can be entered and edited in the text field. Text blocks can contain carriage returns which can be 
created by using the keyboard combinations Ctrl+¶ or Ctrl+m.



Sample
This field shows a preview of what the text will look like.



Font
This section allows you to change the font of the text. The Font Selector shows all available fonts installed
under Windows.



Size
This section allows you to change the size of the text. The available sizes depend on the selected font.



Style
This section allows to change the style of the text. The available types are: Bold, Italic.



Edit Text
With this tool changes to the selected text can be made.



Create new text
With this tool new text can be added.



Delete Text
With this tool all selected text can be deleted.



Align text to left margin
This tool is used to align text to the left margin.



Center Text
This tool is used to center text within the text block.



Align text to right margin
This tool is used to align text to the right margin.



Create scrolling text
This tool is used to create scrolling text, for example, for use at the end of a video clip.



Scroll bar
Preview the scrolling text. 



Text field
Text can be dragged to the Construction Window from the text field.

    When dragging text to the text track, make sure to drag the text block from outside the marked text
block. 



Selected Text
Selected text can be moved and aligned within the text field.



Transparent
This check box is used to turn transparent text on or off.



Center Vertical
This button is used to center text vertically within the frame.



Center Horizontal
This button is used to center text horizontally within the frame.



Preview Window
Video, sound and animation files can be played in the Preview Window.



Edit
Video, sound and animation files can be edited in either the Preview Window or in the Construction 
Window.



Media file
Name of the selected media file.



Starting point
This button is used to set the starting point of the video clip.



End point
This button is used to set the end point of the video clip.



Play
This button is used to start playing the media clip. Click on the button again to stop playing the media clip.



Start
Shows the starting point of the media clip.



Single frame backward
This button is used to move back one position on the media file.



Scroll bar
The scroll bar is used to move the starting point to a desired location on the media clip.



Single frame forward
This button is used to move forward one position on the media file.



End
Shows the end point of the media clip.



Counter
This field shows the current frame position.



Playing time
This field shows the playing time of the selected media file.



Selected area
This field shows the complete clip length or the selected area.



Frames
This field shows the total number of frames in the media clip.



Track
Auf dieser Leiste kann an den Anfang oder das Ende des Regiefensters gescrollt werden.



Edit video track

1. Move:
Click on the media file and move it to the right or to the left (the mouse cursor will change into a white 
hand symbol). Two vertical lines appear showing the start and end points for easy placement of the 
media clip on the time line.

2. Cut:
Clcik on the left or right edge of the clip to select it. The mouse cursor changes into a double-headed 
arrow. The media clip can now be shortened or lengthened as desired (up to the maximinum file 
length). 

3. Time scale
More exact editing of a video can be carried out if a low scale is used.

 If a video file contains a sound track, the sound track can be selected and deleted from the 
Construction window with the 

 button.



Edit transition track
Can be moved, shortened or lengthened as desired.



Edit text track
Can be moved, shortened or lengthened as desired.



Edit sound file
Can be moved, shortened or lengthened as desired.



Image
Pressing this button loads a background image.



Color Settings
This control is used to set the background color of the final video.



Rotations
This field is used to set the number of full turns for the current text.



Rotate around the x-axis
Use this tool to rotate the text along the x-axis.



Rotate around the y-axis
Use this tool to rotate the text along the y-axis.



Rotate around the z-axis
Use this tool to rotate the text along the z-axis.



Direction
Use this tool to change the direction of the rotation.



Move along the x-axis
Use this tool to move the text along the x-axis (left to right).



Move along the y-axis
Use this tool to move the text along the y-axis (top to bottom).



Move along the z-axis
Use this tool to move the text along the z-axis (back to front).



Horizon
This button is used to switch the display of the horizon on or off. 

 It is possible to change the location of the horizon by clicking on it and moving it with the mouse.



Model
This button switches the text view from solid mode to wire frame mode and vice versa. Use the wire frame
mode for faster editing. If necessary, change the "Points per curve" (under Options) to 1 for faster display.



Light Direction
This button is used to set the direction of light. This setting effects colors and shadows.



Background Image
This button is used to switch the display of the background image on or off. 



Font depth
This control is used to set the depth or length of the text.



Space depth
This control is used to set the depth of the space the text is moving in.



Points per curve
This control is used to set the shape of curves within a text. The higher the number, the better the display 
of letters like C, O or G. However, calculating all the points takes a lot of time. It is there recommended to 
use a low setting (1-3) for editing and to change the setting only just before you create the final video.





New
"New" is used to create a new project. The new project is automatically given the name "[Untitled]".

Creating a new project:

1. Select "New" from the "File" menu.
2. If any changes have been made to a former project since it was last saved, the message "Save 

changes to (filename) before closing?" will appear.
3. A new project will be created. The filename "[Untitled]" will appear in the program window title bar.



Open
"Open" is used to open an existing project from any drive or directory.

To open a project:

1. Select "Open" from the "File" menu.
2. All files in the current directory will be displayed.
3. If necessary, change the drive/directory to locate the desired file.
4. Double click on the filename to open.



Save
After a project has been edited, it can be saved to the hard disk using the "Save" function. The project will
be saved using the current filename displayed in the title bar of the program.

To save a project:

1. Select "Save" from the "File" menu.
2. The current project will be saved to the existing filename.
3. You may now continue editing the project or open a new one.

 If many edits are made to a project, it should be saved to disk at regular intervals.



Exit
The "Exit" button is used to close the program window.

To exit the program:

1. Click on the "Exit" button on the Control panel.
2. If any changes have been made to a project since it was last saved, the message "Save changes to 

(filename) before closing?" will appear.
3. If no changes have been made, the program window will be closed and you will return to the Program 

Manager.





New

"New" is used to create a new project. The new project is automatically given the name "[Untitled]".

Creating a new project:

1. Select "New" from the "File" menu.
2. If any changes have been made to a former project since it was last saved, the message "Save 

changes to (filename) before closing?" will appear.
3. A new project will be created. The filename "[Untitled]" will appear in the program window title bar.



Open

"Open" is used to open an existing project from any drive or directory.

To open a project:

1. Select "Open" from the "File" menu.
2. All files in the current directory will be displayed.
3. If necessary, change the drive/directory to locate the desired file.
4. Double click on the filename to open.



Save

After a project has been edited, it can be saved to the hard disk using the "Save" function. The project will
be saved using the current filename displayed in the title bar of the program.

To save a project:

1. Select "Save" from the "File" menu.
2. The current project will be saved to the existing filename.
3. You may now continue editing the project or open a new one.

 If many edits are made to a project, it should be saved to disk at regular intervals.



Save As

"Save As" is used to save the current project to a new filename or in a different directory.

To use the "Save As" command:

1. Select "Save As" from the "File" menu.
2. Choose the directory and subdirectory you wish to save the project in.
3. Enter a filename by typing in the text box or select an existing filename from the list box. 
4. Click on OK.

 If a file of the same name already exists in the chosen location, a warning message will appear.



Exit

"Exit" is used to close the program window.

To exit the program:

1. Select "Exit" from the "File" menu.
2. If any changes have been made to a project since it was last saved, the message "Save changes to 

(filename) before closing?" will appear.
3. If no changes have been made, the program window will be closed and you will return to the Program 

Manager.
.



Before you start

Read the "Readme" file

Make sure you read the "Readme" file for the latest release notes which could not be included in this 
document.



Hardware Requirements

For best results, the following system configuration is recommended:

IBM compatible PC/AT 80486 
4 Mb RAM (minimum)
8-16 Mb RAM (recommended)
VGA or Super VGA video adapter
40-120 MB hard disk
Mouse
XA compatible CD-ROM drive



Software Requirements

MICROSOFT-DOS 3.1 or higher
MICROSOFT-Windows 3.1 or higher



Help File Shortcuts

This Help File supports the following keyboard commands:

ESC key Exit the Help File
HOME key Main Index
LEFT ARROW key Previous Topic
UP ARROW key Previous Topic
RIGHT ARROW key Next Topic
DOWN ARROW key Next Topic
PAGE UP key Back



Driver Requirements

To be able to use "Video for Windows" on your computer, the necessary driver must be installed.

To find out whether the "Video for Windows" driver is already installed, look under "Drivers" in the 
Windows Control panel (located in the 'Main' group in the Program Manager). If it does not appear in the 
"Drivers" dialog box then "Video for Windows" must be installed. 

To be able to utilize the full sound capabilities of "Video for Windows", a compatible sound board and 
associated drivers must be installed in your computer.



Index

This option shows the Help file index of the program.

To display the Help file:

1. Select "Index" from the "Help" menu.
2. The Help file will appear.
3. Select the desired topic from the list provided or use the Search function to locate a particular topic.



Info

This option shows the program information window containing copyright information and the version 
number for the actual program.

To see the program information window:

1. Select "Info" from the "Help" menu.
2. The program information window will appear.
3. Click on OK to close the dialog box and to return to the program window.
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Introduction

Welcome to the Video Logo Generator!

With the Video Logo Generator you can create moving 3D logos from text fonts. Save your creation
to disk as an AVI video file for use in desktop presentations, screen savers or for inclusion in your 
own home video productions.

The Video Logo Generator is easy to use. Text can be added in the font, size and color of your 
choice. Animate the text using transitions to rotate it, zoom in or out or to move it in any direction 
across the screen. A selected color or an image file can be used as a background to make the 
'flying font' more effective.

Once the transitions have been defined, a preview can be made before creating the final AVI video 
file.



General Information

Before you start

Hardware Requirements
Software Requirements
Driver Requirements

Help File Shortcuts

Trademark Information



Menu

File
Help



File

New
Open
Save
Save As
Exit



Help

Index
Info



Dialogs

Control Panel
Video Options
Video Preview

Edit Panel
Text Dialog
Options















Creating a Video Logo

Creating Transitions
Editing Transitions
Loading a Background Image
Previewing a Video Logo
Writing a Video Clip

Tips



Trademark Information

Microsoft, MS-DOS und Windows are registered trademarks of Microsoft Corporation.
Video Logo Generator is a trademark of Software Dynamics GmbH.



Creating Transitions

In order to create movement of the text logo, some thought must first be given to the number of transitions
required and the steps required to achieve the desired result.

The Video Logo Generator requires at least two transitions to be able to generate a video file. To create a 
more complex logo, a higher the number of transitions must be created to achieve the desired effect. 

To add a transition to the transition list when creating a new video logo or to add a transition to an existing
list, click on the "Add" button.

    The transition names as displayed in the transition list can be renamed with the 
"Rename" button to provide an overview of the functionality of each transition.



Editing Transitions

Each new transition should be edited after it is included in the transition list.

Modifications to the text, such as changes made to the text type, size etc. are made globally within a 
project. This means that each transition within a project contains the same text and only the position of 
the text can be changed within each transition.

To edit a transition:

1. Select the desired transition in the transition list.
2. Click on the "Edit" button with the mouse.
3. Change the position of the test with the options available in the Edit panel.



Loading a Background Image

Background images in the Video Logo Generator can be loaded in the BMP graphic file format. All color 
depths such as 16 color, 256 color and 24-bit color are supported. When including a background image in
a video logo, consideration should be given to the output format of the final video. The background image 
should be chosen accordingly so as not to unnecessarily increase the amount of data which must be 
written into the video file which can affect the speed considerably.

To load a background image:

1. Click on the  button with the mouse.
2. All files in BMP format in the current drive/directory will be display.
3. If necessary, change the drive and/or directory to locate the desired file.
4. Double-click the filename to open.
5. The selected background image will appear in the Preview area.



Previewing a Video Logo

In some circumstances, the generation of a video clip can be quite time consuming. In this case, it is 
recommended to make a quick preview with the Preview function before writing the final video file to disk. 

Any changes made within a project, for example changing the position of the text in one transition or 
changing the font means that the output video must be re-generated.

The Preview function provides an overview of the complete video logo and displays it as a wire frame 
model. This is a fast way of checking whether all transitions and settings for the video logo are the way 
you want them.

The following buttons can ge used to make a preview:

    Click on this button to start the preview from the selected position in the list.
    Click on this button to stop the preview. 



Writing a Video Clip

The last step when creating a video logo is to generate the final output video and save it to disk.

The filename and the directory where the output file will be written is the same as for the project file. 
The project must therefore be saved to the hard disk before the video file can be generated. If this has not
been done, a warning message will appear requesting you to save the project file to disk before 
attempting to generate the video file.

1. Click on the "Start" button to begin generation of the video file.
2. The final video can be viewed in the Video Preview dialog box. Click on the "Play" button to start the 

video.

    Depending on the options chosen for the output video, the amount of time required to 
generate the output video file can be very long and the amount of disk space required high.



Tips

1. When loading a background image, the horizon should be set in the Edit panel to correspond to the 
image. The position of the horizon can be modified by clicking on it with the mouse and dragging it to 

the desired location. The horizon can be turned on or off with the  button. 

2. It is possible to adjust the contours of text with the "Points per Curve" setting which can be accessed 

by clicking on the  button in the Edit panel. The higher the number, the better the display of 
letters such as C, O or G. However, calculating all the points takes a lot of time. It is therefore 
recommended to use a low setting (1-3) for editing and previewing a video logo and to change the 
setting to a higher number just before the final output video is to be written.

3. Text is displayed in the edit panel either as a wire frame model or a solid model by clicking on the

 button. The wire frame model provides a much faster display of the text than the sold model. If 
necessary, the text display can be speeded up substantially by reducing the "Points per Curve" setting 
to 1 in the Options dialog box.




